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1 Einführung in Altium Designer 18 
1.1 Einleitung 
 
Die folgende Anleitung beschäftigt sich mit der Erstellung einer Leiterplatte aus einem 
Schematic. Zudem werden wichtige Schritte und Tools zur Erzeugung von Gerber 
Daten erläutert, die in Altium Designer 18 enthalten sind. 
 
Im Zweiten Teil (Kapitel 4) wird die grundlegende Datenaufbereitung mit der Software 
Isocam der Firma Bungard erklärt. 
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1.2 Anlegen eines neuen PCB Projektes 
 
Schritt1:  
Als erstes wie in Abbildung 
1 ein neues Projekt in 
Altium anlegen.  
Dazu im Menü File -> New 
-> Project -> PCB Project 
 
 
 
 
 
 
 
 
 
 
 
 
 

Schritt 2: 
Um ein Platinenlayout erstellen zu können, 
benötigt man einen Schaltplan  
(Schematic). Diesen kann man nach 
Anlegen des Projektes im Menü File, New, 
Schematic hinzufügen. 
(Abbildung 2) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Abbildung 1 Anlegen eines neuen PCB Projektes 

Abbildung 2 Erstellen eines neuen Schematic 
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1.3 Erstellen eines neuen Schematic 
 
Nach erfolgreichem Erstellen eines neuen Schematics sollte folgendes Bild im Altium 
Designer angezeigt werden (Abbildung 3). 
 

 

Abbildung 3 Leeres Altium Designer Schematic 
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1.3.1 Speichern der Schematic Datei 
 
Bevor man mit dem Erstellen der Schaltung beginnt, sollte man die leere Datei mit 
einem Namen speichern. Hier z.B. „Uebung1 Spannungsreglerpcb.projpcb“. Das 
gleiche ebenfalls mit dem Schematic. Hier also auch „Uebung1 
Spannungsreglerpcb.SchDoc“ (Abbildung 5). 
 
 

Abbildung 4 

 
 
 
 
 
 
 

1.3.2 Erstellen des Schaltplans im Schematic Sheet 
 
 
 
 
 
 
 
Anhand eines Beispiels wird im Folgenden erklärt, wie man von einem fertigen 
Schaltplan (Schematic) zu einem PCB-Layout kommt. Folgende Spannungsregler- 
Schaltung aus einem LM317t und geeigneten Block- und Filterkapazitäten wird 
aufgebaut. 
 

 

Abbildung 6 Beispielschaltung Netzteil mit Spannungsregler LM317t 

Abbildung 5 Speicherstruktur der Projekt- und Schematic Datei 
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1.3.3 Altium Bauteile in den Libruaries 
 
Alle Bauteile, die für diese Beispiel- Schaltung 
notwendig sind, sind Standardbauteile der Altium 
Bibliotheken und können aus dem Reiter LIBRARIES 
(Abbildung 7) aus dem Tab auf der rechten Seite 
ausgewählt und in das Schematic gezogen werden.  
 
 
 
 
 
 
 
  

Abbildung 7 Reiter Libruaries 
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1.3.4 Der Altium Bauteile Explorer 
 
Den Spannungsregler LM317t kann man im Bauteile – Explorer (Abbildung 8) unter 
Panel -> Explorer und der Eingabe „lm317t“ finden und per drag-drop in das 
Schematic einfügen. Alle anderen Bauteile sind Bauteile aus der Standard-Bibliothek. 
 

 
 
 
 
 
Nach erfolgreichem Erstellen des Schaltplans (Schematic) nach dem Beispiel kann 
alles abgespeichert werden.  
File -> Save 
 
  

Abbildung 8 Der Altium Designer Bauteile Explorer 
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2 Erstellen einer PCB 
2.1 Einfügen und speichern einer PCB Datei ins Altium Projekt 
 

Nach erfolgreichem Speichern 
des Schematic muss eine neue 
PCB Datei erstellt werden. Dies 
kann wie in Abbildung 9 gezeigt, 
im Menü File -> New -> PCB ein 
PCB hinzufügen getan werden. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Nun sollte im Projektfenster auf der linken Seite die 
erstellte neue PCB unter dem Reiter Free 
Documents erscheinen (Abbildung 10).  
 
 
 
 
 
 
 

 
 

  

Abbildung 9 Erstellen einer neuen PCB Datei ins Projekt 

Abbildung 10 Projektseitenleiste 
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Durch klicken auf File -> Save die PCB Datei mit dem namen „Uebung1 
Spannungsreglerpcb.PcbDoc“ im selben Ordner wie das Projekt speichern. 

Nach Anlegen und speichern der PCB Datei sollte folgendes Bild (Abbildung) zu 
sehen sein (Abbildung 12). 
 

 

Abbildung 12 Leere PCB Datei 

  

Abbildung 11 PCB Datei Speichern 
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2.2 Importieren der Bauteile aus dem Schematic 
 
Damit nun die Bauteile des 
zuvor erstellen Schematic 
in der PCB zur Verfügung 
stehen müssen diese über  
das Menü Design -> Import 
Changes from „.PrjPCB“ 
kann man die Bauteile und 
Net`s des Schematic in die 
PCB laden (Abbildung 13). 
 
 
 
 
 
 
Es erscheint das „Engineering Change Order“ Fenster (Abbildung 14) in dem die 
Veränderungen vom Schematic gegenüber dem PCB verglichen werden und so z.B. 
Änderungen von Pinanordnungen im Schematic detektiert werden können. Dies ist 
hier nicht der Fall. Mit einem Klick auf Validate Changes und Execute Changes werden 
die Bauteile in die PCB geladen.  
 

  

Abbildung 13 Bauteile aus Schematic Importieren 

Abbildung 14 Engineering Change Order 



Anleitung „PCB Layouterstellung und Gerber export mit Altium Designer 18 “ 
Florian Frank 

12  

Sind alle Bauteile in das PCB 
Dokument geladen können 
diese auf die PC geschoben 
werden. Der rot hinterlegte 
Hintergrund kann dabei als 
erstes ausgewählt und 
gelöscht werden [ENTF]. 
Markiert wird durch einfache 
Auswahl mit dem Mauszeiger  
oder mit der 
Tastenkombination [Strg + A].  
 
 
 
 
 
Danach einfach alle Bauteile auf die PCB „schwarzes Feld“ (Abbildung 16) ziehen. 
 

 

Abbildung 16 Bauteile ohne Rahmen auf PCB ziehen 

 
 
  

Abbildung 15 Auf die PCB importierte Bauteile 
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2.3 Anpassen der Platinengröße im Board Planning Mode 
 
Es ist deutlich zu erkennen, dass die Platine 
von den mechanischen Abmaßen her viel zu 
groß ist.  
 
 
 
 
 
 
 
 
 
Um dies anzupassen muss man als nächstes mit [Kurztaste 1] oder [Menü View -> 
Board Planing Mode] ins Board Planing mode wechseln (Abbildung 17). 
 
Nach dem Wechsel ins Board Planing Mode erhält man folgende Ansicht (Abbildung 
18). Die Platine wird Grün dargestellt.  
 
 

 
 
 

 
 
  

Abbildung 18 Platinenansicht Board Planning Mode 

Abbildung 17 Menü Ansicht -> Board Modes 
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Über das Menü Design -> Edit Board 
Shape kann nun grob die Größe der 
Platine für die Schaltung angepasst 
werden (Abbildung 19).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Abbildung 20 PCB Board Planning Mode Markierte Ränder 

An den Rändern (Abbildung 20) der Platine kann man nun die Größe an den 8 Punkten 
der PCB durch anklicken und ziehen mit der Maus möglichst sinnvoll anpassen. 
Danach sollte die Platine grob folgendermaßen aussehen (Abbildung 21). 

Abbildung 19 Menü Design -> Edit Board Shape 
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Abbildung 21 PCB Board Planning Mode Größe angepasst 

 
 
Ist die erforderliche bzw. gewünschte Größe erreicht 
mit der [Kurztaste 2] oder  
[Menü View -> 2D Layout Mode] zurück in den 
Layout-Modus wechseln. 
 
 
 
 
 
  

Abbildung 22 Menü Ansicht -> Board 
Modes 
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2.4 Anordnen und drehen von Bauteilen auf der PCB 
 
Da alle Bauteile mehr oder weniger schlecht bzw. unpassend angeordnet sind sollte 
man nun versuchen diese möglichst sinnvoll anzuordnen, damit später die Leiterbanen 
möglichst platzsparend geroutet werden können. Die grauen Linien (Abbildung 23) der 
Knoten dienen dabei als Orientierungshilfe für die Potentiale bzw. Knoten. 
 

  
 

 

Abbildung 23 Anordnen der Bauteile auf der PCB 

2.4.1 Drehen von Bauteilen auf einer PCB 
 
Um in Altium Designer die Bauteile auf einer PCB zu drehen müssen diese angeklickt 
(somit Markiert werden). Mit gedrücker linken Maustaste erscheint dann ein grünes 
Kreuz (Abbildung 24) auf dem Bauteil. Drückt man nun die Leertaste wird das Bauteil 
um 90 Grad gegen den Uhrzeigersinn gedreht. 
 

 

Abbildung 24 Drehen eines Bauteils auf einer PCB 
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2.5 Einfügen von Bohrungen zur Montage der PCB 
 
Im folgenden Schritt müssen Bohrungen für die spätere Möglichkeit der Befestigung 
der Platine vorgesehen werden. Dies kann durch Hinzufügen von Pads realisiert 
werden dessen Lochdurchmesser so groß ist, wie das eigentliche Pad. Mit der 
Mausauswahl das Pad auswählen und 4 Stück auf der PCB an geeigneten Stellen 
platzieren (Abbildung 25). 

 

 

 

Abbildung 25 Hinzufügen von Montagelöchern 

Als nächstes müssen alle 4 Pads ausgewählt und in ihrer Größe und Bohrung 
angepasst werden. Damit das bei allen gleichzeitig passiert alle mit Shift + Maus Taste 
auswählen. Im Bereich Properties (Abbildung 26) können dann die Größe und die 
Bohrung angepasst werden. Die Löcher sollen 3mm entsprechen (118.11mil). 
 

 

 

Abbildung 26 Anpassen der Montagelöcher 

Danach kann dann das Erstellen der Leiterbahnen vorbereitet werden. Die 
Leiterbahnen können sowohl manuell per Hand, als auch automatisch per Autorouter 
angelegt werden. Hier verwenden wir allerdings die automatische Route Funktion. 
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2.6 Erstellen von Leiterbahnen mit dem Autorouter 
2.6.1 Grundeinstellungen zum automatischen Routen 
 
Bevor mit dem Routen 
begonnen werden kann 
muss man sich 
überlegen, welche Art von 
PCB verwendet werden 
soll. Da wir keine 
Einschränkungen haben, 
entscheiden wir uns für 
2lagige Platinen mit Top 
und Bottom Layer. Damit 
der Autorouter dies 
berücksichtigen kann, 
klickt man im Menü Route 
-> AutoRoute auf Setup 
 
 
 

Es erscheint folgendes Fenster. 
Damit der Router nun Top und 
Bottom Layer nutzt, sollte das hier 
hinterlegte Feld „Default 2 Layer 
Board“ ausgewählt sein. Als 
nächstes muss die 
Leiterbahnbreite und der 
Isolationsabstand eingestellt 
werden. Durch einen Klick auf Edit 
Roules im selben Fenster gelangt 
man in den PCB Rules and 
Constraints Editor. 
 
 
 
 
 
 
 
  

Abbildung 28 Autorouter Situs Routing Strategies Fenser 

Abbildung 27 Autorouter Setup Menü 
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2.6.3 Electrical und Routing Design Rules 
 
Es erscheint folgendes Fenster. Die Ansicht kann je nach verwendetem Computer 
leicht variieren. Wir wollen die Leiterbahnbreite einstellen. Im Reiter Design Rules -
>Electrical finden wir die gesuchten Einstellmöglichkeiten. 
Als nächstes stellen wir zunächst den Isolationsabstand ein. Durch einen Doppelklick 
auf Clearance erscheint oberstes Fenster. 
 
 
 

 
 

 

 
 
 
 
 
 
 
 
 

 

Abbildung 29 PCB Rules Clearance 

 
Wir stellen hier beispielsweise grob 1mm für alle Leiterbahnen ein. Dies entspricht 
39,37mil. Danach alles durch einen klick auf Apply bestätigen.  
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Als nächstes in den Reiter Routing -> Width wechseln. Hier kann die Leiterbahnbreite 
auf der Oberseite (Top Layer) und der Unterseite (Bottom Layer) der Platine 
eingestellt werden.  
 

 

Abbildung 30 Electrical Routing Rules (Leiterbahnbreite) 

 
Hier wählen wir beispielsweise 2mm aus. Dies entspricht dann auch 78.74mil wobei 
Altium beides erkennt. Wir geben also überall 2mm ein und bestätigen mit Apply. 
 
Als nächstes kann man beide Fenster durch klicken auf ok schließen. 
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2.6.4 Auto-Routen von Leiterbahnen 
 
Um nun mit dem Routen zu beginnen alle Bauteile, die geroutet werden sollen 
auswählen und markieren. 
 

 

Abbildung 31 Routevorgang Bauteile markieren 

 
Jetzt im Menü Route -> 
Auto Route auf All... 
klicken.  
 
Es erscheint danach ein 
ähnliches Fenster wie im 
Bereich Route -> Setup 
 
 
 
 
 
 
 

Abbildung 32 Routevorgang RouteAll 
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Hier einfach mit Klick auf Route All  
bestätigen. 
 
 
 
 
 
Nach erfolgreichem Routevorgang 
erscheint das Messages Fenster. 
Sollten im Nachrichtenfenster Fehler 
vorhanden sein, müssen alle 
Einstellungen im Bereich Clearance und 
Width überprüft werden. Ansonsten 
kann das Messages Fenster (Abbildung 
34) einfach  
geschlossen werden. 
 
 
 

 
 

 

Abbildung 34 Messages Fenster 

 
  

Abbildung 33 Fenster Situs Routing Strategies 
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Auf dem Bildschirm sollte danach folgende Ansicht zu sehen sein. 
 

 

Abbildung 35 Fertig geroutete PCB 
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2.7 Board Cutout Line im Mechanical Layer 
 
Als letztes muss nun noch die Außenumrandung angelegt werden, damit bei Erstellung 
der Dateien für die Platinenfertigung die Platine auf die hier angelegte Größe 
(Schwarze Box) ausgeschnitten wird.  
 
Dies geschieht durch Klick auf Design -> Board Shape -> Create Primitives from 
Boardshape (Abbildung 36). 
 

 

Abbildung 36 Erzeugen der Cut Out Line durch die Außenlinien der PCB 

  
Im Folgenden Fenster (Abbildung 37) müssen zwei Dinge beachtet werden. Die Breite 
auf 1mil festlegen und Auf dem Mechanical 1 Layer speichern. 
 

 

Abbildung 37 Erstellen der Board Cut Out Line 
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3 Gerber Export und Datenaufbereitung für 
Leiterplattenfräse 
3.1 Erstellen der CAM Datei 
3.1.1 Vorbereitungen zum Erstellen der CAM Datei 

 
Bevor mit dem Erstellen der Gerber Dateien 
begonnen werden kann, ist sicherzustellen, 
dass der Nullpunkt (Origin) sich an der unten 
linken Ecke (x=0, y=0) der Platine befindet. Ist 
dies nicht der Fall, muss dies geändert 
werden. Dies geschieht durch klick im Menü 
(Abbildung 38) Edit auf Origin -> Set 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Nun kann mit dem Mauszeiger die untere linke Ecke der PCB angeklickt werden und 
der Origin Nullpunkt ist gesetzt. Danach sollte sich der Nullpunkt wie in (Abbildung 
39) an der unteren linken Ecke der Platine befinden. 
 

 

Abbildung 39 Set Origin: Ansicht nach Mausklick 

  

Abbildung 38 Menü Edit Origin Set 
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3.1.2 Erstellen der CAM Datei 
 

Damit die Gerber Dateien für Top, Bottom und 
Mechanical Layer erzeigt werden können, 
muss vorher eine Cam Datei erstellt werden. 
Dazu geht man im Menü (Abbildung 40) File 
auf Fabrication Outputs -> Gerber Files. 
 
 
 
 
 
 
 
 
 
 
 
 

In dem Fenster „Gerber Setup“ (Abbildung 41) muss das Format auf [4:2] gestellt 
werden. Das Ausgabeformat sollte ebenfalls auf [Millimeters] stehen. 
 

 

Abbildung 41 CAM Ausgabe -> Gerber Setup General 

  

Abbildung 40 Menü Fabrication Outputs Gerber 
Files 
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Als nächstes müssen alle gewünschten Layer ausgewählt werden, die ausgegeben 
werden sollen. Hier muss also beim Top, Bottom und Mechanical Layer 1 ein Haken 
unter dem Reiter Plot im Tab Layers (Abbildung 42) gesetzt werden. 
 

 

Abbildung 42 CAM Ausgabe -> Gerber Setup Layers 

 
Als letztes nun noch im Unterpunkt Advanced überprüfen, dass die fürhenden Nullen 
unterdrückt werden und der zuvor gesetzte Nullpunkt (Origin) als Referenz genutzt 
wird. [Surpress Leading zeroes] und [Referece to relative origin] muss ausgewählt 
werden (Abbildung 43). 
 

 

Abbildung 43 CAM Ausgabe -> Gerber Setup Advanced 
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Nach Klick auf OK wird nun die CAM Datei erzeugt. Diese muss dann mit File -> 
Save abgespeichert werden. Dateiname Hier „CAMtatic1.cam“ 
 

 

Abbildung 44 CAM Ausgabe -> Erzeigte CAM Datei CAMtastic1.cam 

 

 

Abbildung 45 Speichern der Cam Datei CAMtastic1.cam 
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3.2 Erzeugen der Gerber Daten 
 

Im nächsten Schritt können nun die Gerber 
Dateien aus der CAM Datei erstellt werden. 
Dazu im Menü File -> Exprt auf Gerber 
klicken.  

 

 

 

 

 

 

 

Es öffnet sich das „Export Gerber(s)“ Fenster. Hier darauf achten, dass das Format 
[RS-247-X] eingestellt ist (Abbildung 47). 

 

 

Abbildung 47 Gerber Export Schritt 1 

  

Abbildung 46 Menü File Export Gerber 



Anleitung „PCB Layouterstellung und Gerber export mit Altium Designer 18 “ 
Florian Frank 

30  

Im Bereich Settings müssen im Fenster [Gerber Export Settings] (Abbildung 48) die 
„Digits“ auf Integer =2 und Decimal = 4 gestellt werden. Es werden ebenfalls 
Metrische Einheiten verwendet. Auch hier sind die führenden Nullen zu unterdrücken. 

 

 

Abbildung 48 Gerber Export Schritt 2 

 

Danach können beide Fenster mit OK bestätigt werden. Als nächstes erscheint 
folgendes Fenster (Abbildung 49), welches mit OK bestätigt werden kann. Der 
Dateispeicherort sollte dem Speicherort des Projektes entsprechen. 
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Abbildung 49 Gerber Export Schritt 3 

 

Im Ausgabeordner, hier „...\Gerber Files werden die Dateien ausgegeben. Es sollte 
dann folgende Dateistruktur vorhanden sein (Abbildung 50). 

 

 

Abbildung 50 Gerber Export Dateistruktur mit Gerber Files 
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3.3 Erstellen der CAM Datei für Bohrungen 
 

Als nächstes muss eine weitere CAM Datei aus der PCB Datei erstellt werden. Diese 
wird dann wiederrum als CAMtastic2.cam ausgegeben und muss wie in Kapitel 3.1.2 
abgespeichert werden. 

Das Erstellen der CAM Datei erfolgt mit Klick auf File-> Fabrication Outputs -> NC 
Drill file (Abbildung 51). 

 

 

Abbildung 51 CAM Ausgabe NC Drill files Schritt 1 

 

In dem Fenster „NC Drill Setup“ (Abbildung 52) muss das Format wie zuvor auch auf 
[4:2], die Units auf [Millimeters] und die führenden Nullen wieder unterdrückt werden. 
Danach alles mit OK bestätigen. 
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Abbildung 52 CAM Ausgabe NC Drill Files Schritt 2 

 

Nach Klick auf OK erscheint folgendes Fenster. Hier müssen im Bereich Units wieder 
das gewohnten Einstellungen vorgenommen werden. Danach alles mit OK 
bestätigen. (Abbildung 53) 

 

 

 

 

 

 

 

 

 

 

 

 

  

Abbildung 53 CAM Ausgabe NC Drill files Schritt 3 Einstellungen 
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Es erscheint die CAMtastic2.cam Datei, die wie im vorherigen Kapitel abgespeichert 
werden muss (Abbildung 54). 

 

 

Abbildung 54 CAM Ausgabe -> Erzeugte CAM Datei CAMtastic2.cam 

 

 

Abbildung 55 Speichern der Cam Datei CAMtastic2.cam 

Nach Klick auf OK wird nun die CAM Datei erzeugt. Diese muss dann mit File -> 
Save abgespeichert werden. Dateiname Hier „CAMtatic2.cam“ Abbildung 55 zeigt 
den Dateispeicherort. 
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3.4 Erzeugen der Drill File(s) 
 

Als letzter Schritt folgt nun das Erstellen der Drill File, die die Koordinaten der 
Bohrungen enthält. Die Datei wird mit Klick im Menü auf File-> Export -> Save Drill... 
erzeigt (Abbildung 56). 

 

Abbildung 56 Menü File Export Save Drill... 

Es erscheint Folgendes Fenster (Abbildung 57). Hier muss der Layer L1 ...txt 
ausgewählt werden und wie in den zu vorigen Export Schritten die Digits [2:4], das 
„Metrische“ Format sowie „führende Nullen unterdrücken“ eingestellt werden. 
(Abbildung 57) Der Dialog kann dann mit ok bestätigt werden.  

 

 

 

 

 

 

 

 

 

 

 

Abbildung 57 Gerber Export NC Drill Fiele Export 
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Als nächstes erscheint das „Write Drill“ Fenster (Abbildung 58), welches mit OK 
bestätigt werden kann. Der Dateispeicherort sollte wieder dem Speicherort des 
Projektes entsprechen. 

 

 

Abbildung 58 Gerber NC Drill File Export Auswahl der drl File 

 

Ist die zu erstellende Datei im Fenster (Abbildung 58) ausgewählt, kann der Dialog 
mit OK bestätigt werden. Die .drl File wird erzeugt und sollte dann im Ausgabeordner 
hier (Abbildung 59) gespeichert sein.  

 

 

Abbildung 59 Ordnerstruktur nach erstellen der Gerber drill File 
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3.5 Datenaufbereitung 
3.5.1 Einlesen der Dateien in die Software Isocam 
 

Um die Dateien in Isocam zu laden, im Menü Datei auf Öffnen klicken und zum 
Dateispeicherort der Gerber Dateien navigieren. Es müssen die Gerber Dateien 
cam.dlr, ...gbl, ...gm1 und ...gtl ausgewählt werden. (Abbildung 60) 

 

 

Abbildung 60 Datenaufbereitung Plotdateien öffnen 

Das Fenster Dateien einlesen ( Abbildung 61) kann mit OK bestätigt werden. 
Danach werden alle Dateien eingelesen und übereinandergelegt angezeigt. 

 

 

 Abbildung 61 Datenaufbereitung Isocam Fenster Daten einlesen 
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Abbildung 62 zeigt alle übereinander gelegten Dateien. Als nächstes muss jeder 
Layer einzeln ausgewählt und die Fräsdaten erzeugt werden. 

 

 

Abbildung 62 Fertig geladene Gerber Files übereinandergelegt. 

3.5.2 Erzeugen der Fräsdaten für den Machenicel Layer 
 

Im ersten Schritt den Machanical Layer, der den Umriss der Platine enthält im Isocam 
Fenster unten links auswählen (Abbildung 63). 

 

 

Abbildung 63 Auswahl Layer L1 Isocam 
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Als nächstes im Menü Datei -> Fräsdaten 
erzeugen auswählen.  

 

 

 

 

 

 

Es erscheint das Fenster „Fräsparameter 
bearbeiten“ (Abbildung 65) Hier für den Fräser 
1 1.0mm auswählen. Fräser 2 wird nicht 
benutzt. Die Fräsgenauigkeit sollte auf normal 
gestellt werden. 

 

 

 

 

Abbildung 65 Fenster Fräsparameter bearbeiten 

  

Abbildung 64 Menü Fräsdaten erzeugen 
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Nach erzeugen der Fräsdaten erscheinen die Fräskonturen (grau) auf dem 
Bildschirm (Abbildung 66). 

 

Abbildung 66 Erzeugte Fräskonturen des Mechanical Layers 

 

Im nächsten Schritt muss der Auswahlmodus geändert werden um die inneren 
Konturen auswählen zu können. Wie das geht, zeigt Abbildung 67. 

 

 

Abbildung 67 Isocam Auswahl Fräsobjekte 
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Im Auswahlmodus „Fräsobjekte“ mit dem Mauszeiger die inneren Linien (Abbildung 
68) auswählen und mit der Taste Entf oder mit Rechtsklick aus „Löschen“ löschen. 

 

 

Abbildung 68 Auswahl Fräsobjekte-> Innere Linien markieren 

 

 

Damit die freigestellte Platine nicht lose auf der Fräse 
liegt, müssen Stege stehen bleiben. Hier reichen zwei 
Stege vollkommen aus. Einer auf der linken und einer 
auf der rechten Seite. Dazu jeweils die linke und rechte 
Seite im Auswahlmodus „Fräsobjekte“ wie in (Abbildung 
69) markieren. 

  

  

  

  

  
 

Abbildung 69 Vorbereitung: Stege linke Seite markiert 
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Um die Stege zu erstellen mit rechter Maustaste auf den jeweiligen Steg klicken. 
Dann auf „Stege in Fräslinien erzeugen“ klicken und einen Steg mit 1,5mm Lücke 
erzeugen (Abbildung 70). 

 

 

 

Abbildung 70 Stege in Fräslinien erzeugen 

 

Sind die Stege erfolgreich angelegt können die Fräsdateien für den Mechanical 
Layer gespeichert werden. Dies geschieht wieder durch einen Klick im Menu Datei -> 
Fräsdaten Speichern. 

 

 

Abbildung 71 Speichern der Fräsdaten 
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Die zu speichernde Fräsdatei wird mit dem namen „mech“ im Dateiformat HPGL 
gespeichert. 

 

 

Abbildung 72 Dateistruktur „Speichern unter“ 
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3.5.3 Erzeugen der Fräsdaten für den Top und Bottom Layer 
 

Wie zuvor in Kapitel 3.5.2 wird nun jeweils Top und Bottom Layer ausgewählt. 

 

Abbildung 73 Auswahl Top Layer 

 

Mit einem erneuten Klick im Menü Datei auf „Fräsdaten erzeugen“ werden die 
Umrisse (hier Top Layer) gezeichnet. (Abbildung 74) Danach kann direkt im Menü 
Datei der Punkt „Fräsdaten Speichern die Datei mit dem Namen „Top.HPGL“ 
gespeichert werden. 

Gleiche Vorgehensweise wird dann mit dem Bottom Layer durchgeführt. (Abbildung 
75) 

 

 

Abbildung 74 Erzeugte Fräslinien Top Layer 
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Abbildung 75 Erzeugte Fräslinien Bottom Layer 

 

Nach Erzeugen der Fräsdaten für den Bottom Layer können diese ebenfalls direkt im 
Menü Datei unter Fräsdaten Speichern mit dem Namen „Bot.HPGL“ gespeichert 
werden. 
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3.5.4 Erzeugen der Fräsdaten für die Bohrdatei 
 

Um die Bohrdaten zu erzeugen, muss der Layer mit der cam.drl ausgewählt werden 
(In Abbildung 76 hier gelb). 

 

 

Abbildung 76 Auswahl Drill Layer 

An den Drill Files muss hier nichts geändert werden. Nach der Auswahl des Layers 
kann die erzeugte Datei direkt wie in (Abbildung 77) zu erkennen im Menü Datei 
„Speichern Unter“ die Datei unter dem Namen „drill.nc“ gespeichert werden. 

 

 

Abbildung 77 Bohrdaten Speichern unter 
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Abbildung 78 Erzeugen der Bohrdaten für die Bohrungen 

 

Um die Bohrdaten so abzuspeichern, dass die Frässoftware der bungard Fräse sie 
einlesen kann, müssen die Parameter wie in Abbildung 78 eingestellt werden. Wichtig 
ist hier das Zahlenformat 2:4 und dass hier eine umkonvertierung von mm/inch 
vorgenommen wird. Andernfalls kann es zu Problemen beim Einlesen der Fräsdaten 
kommen. Zum Speichern der Datei einfach den Dialog mit OK bestätigen. Es erscheint 
der gewohnte „Speichern unter“ Dialog (Abbildung 79). 
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Abbildung 79 Speichern unter Dialog Bohrdaten 

 

Abbildung 79 zeigt nun die Dateistruktur der zu fräsenden Dateien. Diese können so 
direkt von der Frässoftware gelesen und verarbeitet werden. 
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4 Einlesen der aufbereiteten Dateien in die Frässoftware 
 

Um die Fräsdaten einzulesen wird die Frässoftware RoutePro3000 der Firma 
bungard verwendet. Nach öffnen der Software und einem Klick auf „Assistent“ 
erscheint der Projektassistent auf dem Bildschirm (Abbildung 80). 

 

Abbildung 80 RoutePro Projektassistent Schritt 1 

4.1 Der Projektassistent 
 

Der Projektassistent fragt die erforderlichen Einstellungen für die Fräsung in 
einigen Schritten ab. Im ersten Schritt (Abbildung 81) des Assistenten ein 
Projekttyp und ein Name eingetragen werden. Hier z.B. 
„Uebung01_Spannungsregler“ 

 

 

Abbildung 81 RoutePro Projektassistent Schritt 2 
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4.2 Auswahl der zu fräsenden Dateien 
 

 

 

 

 

 

 

 

 

Im nächsten Schritt (Abbildung 82) müssen alle Dateien, die dem Projekt hinzugefügt 
werden sollen ausgewählt werden, damit diese später gefräst werden können. 

  

Abbildung 82 RoutePro 3000 Dateiauswahl 
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Fräserauswahl 
 

 

Abbildung 83 RoutePro 3000 Fräserauswahl Beispiel 

Für jede ausgewählte Fräsdatei werden die erforderlichen Bohrer und Frästools 
abgefragt. Diese Informationen sind wichtig, wenn der automatische 
Werkzeugwechsler (AFC) verwendet wird, oder die jeweilige Frästiefe eingestellt 
werden muss. 

Sind alle Bohrer und Tools eingerichtet kann der Assistent am Ende mit Fertigstellen 
geschlossen werden. Es erscheint in unserem Beispiel folgende Fräsübersicht mit 
allen Frästeilen (Abbildung 84). 

 

Abbildung 84 RoutePro 3000 Fräsübersicht 
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4.4 Fräsen der Platine 
 

Nun sind alle erforderlichen Daten eingelesen und die Frässoftware ist nach Einlegen 
des Fräsmaterials, hier das PCB Grundmaterial, bereit für die Fräsung. Mit einem Klick 
auf Start (Abbildung 85) wird der Fräsvorgang gestartet. 

 

 

Abbildung 85 RoutePro 3000 Start Button 
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